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Dear Technology Leader:

As the school year heads into its home stretch, there’s no better wrap-up for students and teachers
than learning-rich classroom technology projects that tie together all the strands of your curriculum.
That’s what this special Spring/Summer Microsoft Productivity in the Classroom workbook has to offer.

Drawing on the exemplary work of technology-using classroom educators across the country (see
below), this fifth edition of Microsoft Productivity in the Classroom is designed to make the most of
your school’s Windows or Power Macintosh computers and the latest in productivity software. The
ten lesson plans in this workbook were designed for use with the brand-new Microsoft Office 2000
Professional Edition (Microsoft® Word 2000, Microsoft® Excel 2000, Microsoft® PowerPoint® 2000,
Microsoft® Access 2000, Microsoft Publisher 2000, and Microsoft Outlook 2000) as well as Microsoft®

Office 98 Macintosh Edition (Microsoft® Word 98, Microsoft® Excel 98, Microsoft® PowerPoint® 98). Many
of the lessons also integrate other Windows products, such as the Microsoft® FrontPage 98/2000 web
authoring tool, Microsoft® Encarta 99 Reference Suite, and the acclaimed Microsoft® Encarta Africana,
while taking advantage of online resources with Microsoft® Internet Explorer 4.5/5.0. All lessons
include step-by-step instructions for using software effectively while weaving it into the curriculum.

Developed by the editors of Scholastic’s Instructor and Electronic Learning in Your Classroom in part-
nership with the Microsoft Corporation, this workbook can be an effective tool for both teachers
and staff developers. With lessons like these, you’re sure to finish the school year with a flourish!

Sincerely,

Mickey Revenaugh
for Instructor/Electronic Learning in Your Classroom

P.S. More free resources to help teachers use technology are available at:

www.microsoft.com/education/k12/classroom
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Lessons at-a-Glance

productivity in the

LESSON GRADE LEVELS TIME ALLOTTED

PLAN A MILLENNIUM
CELEBRATION

AROUND THE
PACIFIC RIM

WHAT�S THE 
REAL DEAL?

NEWS AND ETHICS
IN THE DIGITAL AGE

GIANTS OF THE 
CENTURY

Middle School

High School

All grade levels

High School

Primary/Intermediate

Primary

Intermediate

Intermediate

Four to six class periods

Eight class periods

Three class periods

Two to three class periods

Three class periods and
ongoing

Two to three class periods

Four class periods

Three class periods

Three to four class periods

Middle School/High School

PrimaryTHE INSECT FILES Six to eight class periods 

classroom
ONCE UPON A
THANK YOU

SHAKE, RATTLE,
AND ROLL

DISCOVERING
JUNETEENTH

FASTBALL PHYSICS



SOFTWARE NEEDED PAGE CURRICULUM CONNECTION

Language
Arts

Geography Math Science
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6

34

27

31

24

20

16

9

12

4

Microsoft PowerPoint 98/2000
Microsoft Encarta Deluxe Encyclopedia 99
Microsoft Internet Explorer 4.5/5.0
Microsoft Paint (Windows Accessory)

Microsoft Publisher 98/2000

Microsoft Excel 98/2000
Microsoft Word 98/2000
Microsoft Internet Explorer 4.5/5.0
Microsoft Encarta Deluxe Encyclopedia 99 

Microsoft Word 98/2000
Microsoft Encarta Deluxe Encyclopedia 99
Microsoft Internet Explorer 4.5/5.0
Microsoft PowerPoint 98/2000
Microsoft Encarta Virtual Globe 99

Microsoft Word 98/2000
Microsoft PowerPoint 98/2000
Microsoft Publisher 98/2000
Microsoft Internet Explorer 4.5/5.0

Microsoft Encarta Africana
Microsoft Word 98/2000
Microsoft Internet Explorer 4.5/5.0

Microsoft Word 98/2000
Microsoft Encarta Deluxe Encyclopedia 99
FoilSim Wind Tunnel Simulator (Freeware)

Microsoft Word 98/2000
Microsoft PowerPoint 98/2000
Microsoft Internet Explorer 4.5/5.0

Microsoft Internet Explorer 4.5/5.0
Microsoft Word 98/2000
Microsoft FrontPage 98/2000

Microsoft Word 98/2000
Microsoft Encarta Deluxe Encyclopedia 99
Microsoft Internet Explorer 4.5/5.0
Microsoft Access 2000

Social
Studies

Special Cross-Curriculum
Class Project



In the course of the year, kids
have encountered a wide vari-
ety of authors and  characters
through the storybooks they
have read for class. This pro-
ject will encourage readers to
revisit their favorite books and
recall just what it was about
the author who wrote each
book --- or the characters the
author created --- that made the
story so special. Kids will then
celebrate their chosen authors
and/or characters with fun
thank you cards they create on
your classroom computer.

♦ To choose favorite books,
authors, and characters, and
articulate why they’re favorites.

♦ To share opinions about
books with fellow students.

♦ Introduction to Microsoft
Publisher 98/2000.

3 class periods

1. From among the storybooks
your class has read this year,

choose several authors and/or
characters you like best. 

2. Launch Publisher on a com-
puter in your classroom that
students can gather around for
a demonstration.

3. Bring your class together,
and model for your students
how you think about your
favorite authors and charac-
ters.  For example, you might
hold up Green Eggs and Ham
and say, “Dr. Seuss is one of
my favorite writers, because
the way he uses words is so
funny and different.” Or you
might hold up a book from the
Magic School Bus series and

say, “I just love Ms. Frizzle:
she makes learning an amaz-
ing adventure!”

4. Next, follow the steps laid
out in the Student Activity to
create a thank you card for
your favorite author or charac-
ter. After your print out your
card, pass it around to stu-
dents and tell them it’s time to
create cards of their own.

5. While your students are
working, set up a table near
your classroom library where
students can display their fin-
ished cards with the books
that match.

Teacher Guide

ONCE UPON A
THANK YOU

PRIMARY REQUIRED SOFTWARE

♦ MICROSOFT® PUBLISHER 98/2000

SUMMARY

OBJECTIVES

PREREQUISITE SKILLS

TIME ALLOTTED

HOW TO BEGIN
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Kids use Microsoft Publisher to celebrate their favorite character.



Who wrote the books that you
like best? Which characters
made you wish the story would
never end? Now’s the time to
say “Thank you!” to those who
have made reading so much fun.

Choose Favorites
SOFTWARE: None

WHAT TO DO:

1. When you think about all
the books you’ve read this
year, which ones do you
remember liking the best?
Make a list of at least three
books you might call your
favorites. Then go get those
books from your classroom or
school library, or bring them in
from your collection at home.

2. Look at who wrote your
favorite books. Choose the
one author you like very best.
What would you say to this
author if you had the chance?

3. Now think about the char-
acters you have met through
these books. Which one would
you most want to meet in real
life ---- and what might you say?

4. Write a note to yourself
about your answers to 2 and 3. 

Create Cards
SOFTWARE: Microsoft
Publisher 98/2000

WHAT TO DO:

1. Go to a computer where
your teacher has launched

Publisher. On the Catalog
screen, click the Publications
by Wizard tab. Click on
Greeting Cards, and then
Thank You.

2. Use the scroll bar to pre-
view the many styles and
thank you cards. Choose one
you like best for the first
author or character on your
list, and double-click to open it.

3. Read the Greeting Card
Wizard introduction, then click
Next. The next few screens will
ask you to choose layouts,
color schemes, sizes and folds,
and suggested verses. In the
Personal Information screen,
choose Home/Family and click
Personal Name. In the text box
that appears, type your name. 

4. After you make each choice,
click Next. At the end, after
you click Finish, you can still
go back and change your mind
about any of these choices.

5. Next, click areas of your
card where the words are, and
type a new message that’s just
right for the author or charac-
ter you want to thank. 

6. Fine-tune your card, proof-
read it, and print.

7. Repeat for each author or
character on your list. Or try
something a little different: on
the Catalog screen, choose
Postcards, and then click
Thank You and follow the wiz-
ard steps to create a postcard
instead.

Special Delivery
SOFTWARE: Microsoft
Publisher 98/2000

WHAT TO DO:

1. Display each card with the
book it matches in a special
library area your teacher has
set up. 

2. Read the cards your class-
mates have created, then look
through the books they’re
related to. (Don’t be surprised
if some of your favorites get
cards from other kids, too!)
Choose one or more new
books to read...and keep
those cards coming!

ONCE UPON A THANK YOU

Student Activity
DESCRIPTION

STEP A

STEP B

Find more great lessons at: www.microsoft.com/education/curric/activity Productivity in the Classroom 5

STEP C

With Publisher, you can make your thank you cards kind of funny...or not!



Movies like last year's Antz and
A Bug's Life gave kids an up-
close, if fanciful, view of the
insect world. Build on their
interest with this research 
project, in which students find
out all about the insect of their
choice and then show what
they know through a multime-
dia presentation to the class.

♦ To provide a physical
description of the insect, in
words and graphics, including
body parts, special adapta-
tions, color, and so on.

♦ To explore and report on all
four elements of an insect's
habitat: food, water, shelter,
and environment.

♦ To diagram the insect's life
cycle.

♦ Basic presentation skills
using Microsoft PowerPoint
98/2000.

♦ Research skills using
Microsoft Encarta Deluxe
Encyclopedia 99 and Microsoft
Internet Explorer 4.5/5.0.

♦ Practice at importing and
using clip art, pictures and
other graphic information.

6 ---  8 class periods

1. To prepare before introduc-
ing this project to your class:

♦ Gather print resources on
insects, including books and
magazine articles appropriate
for your students' ages and
reading levels.

♦ Open Encarta Encyclopedia
and go to Encyclopedia
Articles. Click FIND in the
menu bar to open the
PinPointer, and type in Insect.
Read through the articles and
choose several for your stu-
dents, then go to Favorites and
choose Add to Favorites... to
help your students find them. 

♦ Check out the Web sites 
listed below and add the best
ones to your Favorites list for
easy retrieval.

♦ Open PowerPoint and create
a template that includes slides
with the following titles: “Title
Slide,” “Insect Picker,” “Bug
Body Parts,” “Life Cycle,”
“Food,” “Water,” “Shelter,” and
“Environment.” Use AutoLayout
to choose the slide formats.
The “Title Slide” should be in
the title slide format; the “Insect
Picker” slide should have a title
and bulleted text; and the oth-
ers should include text and clip
art. Go to View, select Master >
Slide Master, and add a footer
that reads “The Insect Files.”
Each student will save a copy
of this file and use it for his or
her presentation.

2. Introduce the project by
reviewing with students how
insects are different from
other animals. 

3. To provide students with a
starting point for their research,
brainstorm as a class to create
a list of all the different kinds of
insects you can think of.

4. Hand out the Student
Activity pages, review the
steps with your class, and
then set students loose to cre-
ate their own “Insect Files”
presentations.

6 Productivity in the Classroom Find more great lessons at: www.microsoft.com/education/curric/activity

Teacher Guide

THE INSECT FILES

PRIMARY REQUIRED SOFTWARE

♦ MICROSOFT® POWERPOINT® 98/2000

♦ MICROSOFT® ENCARTA® DELUXE ENCYCLOPEDIA 99

♦ MICROSOFT® INTERNET EXPLORER 4.5/5.0

♦ MICROSOFT® PAINT (WINDOWS® ACCESSORY)

SUMMARY

OBJECTIVES

PREREQUISITE SKILLS

TIME ALLOTTED

HOW TO BEGIN

INSECT WEB SITES
Insect World: A scholarly but fun
introduction to the creepie-crawlies.
http://www.insectworld.com

The Bug Club: A junior 
entomologist's playground.
http://www.ex.ac.uk/bugclub/

The Yuckiest Site on the Internet:
Science with a funny bone; includes
a special area on cockroaches.
http://www.yucky.com/roaches

The Insect Hotlist: A collection of
linked sites about insects, including
some rich in graphics.
http://sln.fi.edu/tfi/hotlist/insects.html



From beautiful butterflies to
the cockroaches nobody loves,
there are more insects on our
planet than any other kind of
creature. Here's your chance
to get to know one insect very
well, as you create your own
multimedia report called “The
Insect Files.” 

Pick an Insect
SOFTWARE: Microsoft
Encarta Deluxe Encyclopedia
99, Microsoft Internet
Explorer 4.5/5.0, Microsoft
PowerPoint 98/2000

WHAT TO DO:

1. Answer these questions to
help you pick your insect: Do
you want a flyer or a crawler?
Backyard bug or one from a
faraway place? Big or small?
Open the PowerPoint template
your teacher has set up for
you, go to the “Insect Picker”
slide, and type in your answers. 

2. Read the Encarta
Encyclopedia articles about
insects that your teacher has
selected. Find insects that fit
into your list and add them to
your “Insect Picker” slide. List
at least three insects you want
to know more about.

3. Look for information about
your three choices in Encarta
Encyclopedia and the other
books, magazines and Web
sites your teacher has selected.
Copy key facts and Web
addresses you might want to
return to and paste them into
your “Insect Picker” slide. If
you run out of room, create
additional “Insect Picker”
slides by going to the Edit
menu and choosing Duplicate.  

4. Meet with your teacher, dis-
cuss your three insect choices,
and pick one. In your “Insect
Picker” slide, put a star next to
the insect you chose, then
print out the slide and post it
on the bulletin board to help
other kids in their search.

Bug Body Parts
SOFTWARE: Microsoft Paint,
Microsoft Encarta Deluxe
Encyclopedia 99, Microsoft
Internet Explorer 4.5/5.0,
Microsoft PowerPoint 98/2000

WHAT TO DO: Now that you've
chosen your insect, you need
to get to know it better by
studying its body parts.

1. Launch Microsoft Paint by
going to the Start menu and
selecting Programs >
Accessories > Paint.

2. Go back to your Encarta
Encyclopedia and Internet
sources, and search for pic-
tures that show all the differ-
ent parts of your insect. Copy
these pictures using the Copy
Image function in Encarta
Encyclopedia. Paste each one
into Paint and save.

3. Open your PowerPoint file, go
to Slide Sorter, and click on the
“Bug Body Parts” slide. Go to Edit
and click Duplicate to copy your
blank “Bug Body Parts” slide.
Repeat to create as many blank
slides as you have pictures. Then
go to each slide, go to Insert, click
Picture > From File..., and choose
one of your saved insect pictures.

4. Look at your “Bug Body
Parts” slides and choose the
one that shows your insect's
body parts most clearly. 

5. Now  label the body parts. Go
to View, choose Toolbars, and
click Drawing. Pick Autoshapes,
and click Callouts. Use callouts
to label each part on your best
insect picture. Make sure that

THE INSECT FILES

Student Activity
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DESCRIPTION

STEP A

STEP B
INSECT FACTS

♦ Insects have exoskeletons
instead of bones. 

♦ All adult insects have three main
body parts: head, thorax, and
abdomen.

♦ The thorax has three sections,
each bearing a pair of legs -- for a
total of six legs.

Microsoft Encarta Encyclopedia is a good source of insect information.



you've included the head, thorax,
and abdomen, and also point out
your insect's six legs. Save your
PowerPoint file.

Life Cycle
SOFTWARE: Microsoft Paint,
Microsoft Encarta Deluxe
Encyclopedia 99, Microsoft
Internet Explorer 4.5/5.0,
Microsoft PowerPoint 98/2000

WHAT TO DO:

1. Using your Encarta
Encyclopedia and Internet
sources, find out which kind
of life cycle your insect has:

♦ Three stages: Egg/Nymph/
Adult (also known as "incom-
plete metamorphosis")

♦ Four stages: Egg/Larva/
Pupa/Adult (also known as
"complete metamorphosis")

2. Look for and copy pictures
or diagrams of your insect in
each stage of its life cycle.
Paste into Paint and save.

3. Open your PowerPoint file
and go to your “Life Cycles”
slide. Go to the Insert menu,
menu, choose Picture > From

File..., and insert the life cycle
picture(s) you have saved.

4. Insert a text box beneath
each picture and add text to
describe that stage of the life-
cycle. Save your PowerPoint
presentation.

Insect Habitat
SOFTWARE: Microsoft
Encarta Deluxe Encyclopedia
99, Microsoft Internet
Explorer 4.5/5.0, Microsoft
PowerPoint 98/2000

WHAT TO DO: Every insect
needs three things in its habi-
tat in order to survive: food,
water, and shelter. These
things may be shaped by the
larger environment in which
the insect lives, such as the
desert, wetlands, or forest.

1. What does your insect eat?
Search for answers to this ques-
tion in Encarta Encyclopedia and
Internet sources. Find and copy
pictures of your insect's favorite
meals or a picture of it eating.
Then open your PowerPoint file,
go to the “Food” slide, and
Insert pictures and text.

2. Where does your insect
find water---and how does it
drink? Repeat the process in
Step D-1 to create your
“Water” slide in PowerPoint.

3. What does your insect do for
shelter? Look for answers, in-
cluding pictures or diagrams, to
include in your “Shelter” slide.

4. What is your insect's larger
environment? Get more infor-
mation about your insect’s
habitat and include it in your
“Environment” slide.

Polish and Present!
SOFTWARE: Microsoft
PowerPoint 98/2000

WHAT TO DO: Now turn your
report into a facinating show
for your classmates.

1. Look over each slide care-
fully, and correct any spelling
errors or messy graphics.

2. Hide any slides that are
more for your own notes than
for the presentation by going
to Slide Show and choosing
Hide Slide.

3. Add an opening slide that
shows your insect's name, a
picture of it, and your name.

4. Now add some fun ways to
move your presentation from
one slide to the next. In the
Slide Show menu, click on
Slide Transition for transition
and sound options. 

5. Save your PowerPoint pre-
sentation, then go to Slide
Show, choose View Show, and
rehearse your presentation,
using the arrow keys to move
from one slide to the next.

6. Present your report and
have fun!

THE INSECT FILES
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STEP D

STEP E

STEP C

Tell the world about your favorite insect with a PowerPoint slide show.



How would your students
mark December 31, 1999, if
they could design the celebra-
tion of their own choice? With
this project, kids focus on the
coming change of millennium
while developing their math
and language skills.

♦ To decide how to celebrate
the millennium as a class.

♦ To develop schedules and
budgets for the celebration.

♦ Ability to write and edit
using Microsoft Word 98/2000.

♦ Basic familiarity with
Microsoft Excel 98/2000.

♦ Fundamental Internet
research skills using Microsoft
Internet Explorer 4.5/5.0.

4 class periods

1. Preview the Web sites list-
ed in Step A on the next page,
and add as Favorites the sites

you think will be most useful
to your students.

2. Remind students that not
only is 1999 the last year of the
20th century, it is also the last
year of the millennium ---- a 
period of 1,000 years. Note that
people around the world are
planning special celebrations
for this milestone, and now it's
your students' turn to think
how your class might best
mark the millennium.

3. With your students, create a
Millennium Countdown clock.
Launch Excel and open a new
workbook. Follow the format of
the worksheet below to set up
your clock. For cell B3, go to
Insert, choose Function, select

Date & Time as the category,
and click on NOW. This will
insert a dynamic date and time
that's always current. In cell
B5, type 1/1/00 12:01 AM. For
the cell that calculates the
days and hours until the mil-
lennium, create a formula that
subtracts the NOW cell from
1/1/00, 12:01 a.m. In the sam-
ple, it's =B5-B3. Save the clock,
and display it while students
work.

4. Display students’ complet-
ed celebration proposals on
the classroom bulletin board,
or help them save their docu-
ments as HTML to post on
your school intranet.

Teacher Guide

PLAN A MILLENNIUM
CELEBRATION

PRIMARY/
INTERMEDIATE

REQUIRED SOFTWARE

♦ MICROSOFT® EXCEL 98/2000

♦ MICROSOFT® WORD 98/2000

♦ MICROSOFT® INTERNET EXPLORER 4.5/5.0

♦ MICROSOFT® ENCARTA® DELUXE
ENCYCLOPEDIA 99

SUMMARY

OBJECTIVES

PREREQUISITE SKILLS

TIME ALLOTTED

HOW TO BEGIN
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Let Microsoft Excel do the counting and you’ll have more time to plan
the party! 



New Year's Eve may seem like
a long time away, but there's
good reason to start planning
now for December 31, 1999.
That's because this New Year's
Eve is actually the kick-off of
not only a new century but
also a new 1,000-year period
known as a millennium. So
what should your class do to
celebrate? You decide!

Choose Your
Celebration
SOFTWARE: Microsoft
Internet Explorer 4.5/5.0,
Microsoft Encarta Deluxe
Encyclopedia 99, Microsoft
Word 98/2000

WHAT TO DO: How should
your class celebrate the
change of the millennium?
Here's your chance to imagine.

1. First, know the ground
rules: 

♦ You have $2,000 to spend for
a class millennium celebration.

♦ Your celebration can take any

shape you want, but it should
be meaningful and exciting.

♦ You will need to carefully
schedule and budget your 
celebration.

2. Next, consider these possi-
bilities to jumpstart your think-
ing (you may come up with
something totally different!):

♦ A party for the class, the
school, or the whole 
community

♦ A journey to a symbolic
location, such as Antarctica,
New York City, or the
International Date Line

♦ A public art project such 
as a sculpture or exhibit 
commemorating the past or
celebrating the future

♦ A donation to a cause you
feel is important

♦ A multi-media technology
project bringing history to life
or bringing people together
from faraway places

3. Check out these Web sites
to see what other people are
planning for the millennium:
http://www.everything2000.com/,
http://www.newyearseve2000.com/,
and http://www.countup2000.com/.

4. Launch Word, open a new
document, and write a para-
graph that answers these ques-
tions: How should your class
celebrate the millennium, and
why is this idea the best one?

Create Your
Budget
SOFTWARE: Microsoft Excel
98/2000

WHAT TO DO: How will you
spend your $2,000 celebration
fund? Create a budget to plan it.

1. Open a new Excel workbook.

2. In cell A1, type the label
Item. In the cells below, list
each of the items you'll need
for your celebration.

3. In cell B1, type the label
Unit Price. In C1, type Unit. In
D1, type # of Units. In E1, type
the label Subtotal.

4. In cell E2, create the follow-
ing formula: =B2*D2. Select the
cell, point to the handle in the
lower right corner, and drag to
copy the formula down Column
D to the last of your items.

5. In the row beneath your
last item, type TOTAL. In the
cell where that row meets
Column E, enter the formula
=SUM followed by an open
parenthesis, select the subto-
tal cells for all your items,
then type a close parenthesis.

6. Do some research to pin
down the price of each item.
Some prices (such as those
for travel) you might find on
the Internet, while others
(such as food for a party)
you'll want to find from local
merchants.

PLAN A MILLENNIUM CELEBRATION

Student Activity
DESCRIPTION

STEP A

STEP B

10 Productivity in the Classroom Find more great lessons at: www.microsoft.com/education/curric/activity

A Microsoft Excel worksheet will help you budget your celebration fund. 



7. Adjust as necessary to keep
your total at or below $2,000.

Plan Your
Schedule
SOFTWARE: Microsoft Excel
98/2000

WHAT TO DO: Now that you
know how you'll finance your
celebration, plan a timeline
for making it happen.

1. Click on the Sheet 2 tab at
the bottom left of your Excel
worksheet to open a new
worksheet.

2. In A1, type the label Task.
In B1, type Done By. In C1,
Days Until Celebration.

3. In Column A, list the vari-
ous steps you'll need to take
to bring your celebration to
fruition. If you're planning a
bus trip to the Continental
Divide, for example, include
renting the bus, mapping the
route, confirming passengers,
departure date and time, and
arrival time. Make your last
task the actual celebration, on
December 31, 1999.

4. Assign dates to each task
in Column B. Select this col-
umn, choose Format, choose
Number, and select the
mm/dd/yy format.

5. Select Column C, choose
Format, choose Number, and
select General.

6. In cell C2, type in a formula
to subtract the date in this
cell from 12/31/99. The result
will show you the number of
days between this task and
your celebration.

Preview Your
Celebration
SOFTWARE: Microsoft Word
98/2000, Microsoft Excel
98/2000

WHAT TO DO: Pull together
all your plans into a polished
final report.

1. Reopen your Word docu-
ment from Step B. 

2. Create a fancy heading by
going to Insert, choosing
Picture, and clicking on
WordArt. Give your celebra-
tion a catchy name, perhaps
one that includes your own
first name.

3. Flesh out your paragraph
to provide a much more
detailed description of your
planned celebration. Add pho-
tos and other graphics from
the Web and Encarta
Encyclopedia.

4. Create a section heading
for your budget. Write a few

sentences of introduction,
then go to your Excel work-
sheet, select the cells that
make up your budget, go to
Edit, and select Copy. Go back
to your Word document and
paste in your budget.

5. Repeat for your schedule.
6. Proofread, polish, and print.
Hand in to your teacher to 
display on the class bulletin
board.

PLAN A MILLENNIUM CELEBRATION

STEP C

STEP D
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Use Microsoft Excel to create a schedule for your millennium celebration.

Present your celebration idea as
a polished Microsoft Word docu-
ment, with graphics and charts.



With all the apocalyptic pre-
dictions kids might be hearing
about the millennium, it’s a
good time to set the record
straight about at least one
kind of natural disaster. This
activity will feed the students’
curiosity and fascination with
earthquakes while teaching
them fundamental research
and reporting skills.

♦ To teach students facts
about earthquakes ----  how they
are caused, what they do,
efforts at predicting them,
how to prepare for one. 

♦ To help students improve
their research, reporting, and
presentation skills.

♦ Basic experience with
Microsoft Word 98/2000.

♦ Basic skills using Microsoft
Encarta Deluxe Encyclopedia
99, Microsoft Encarta Virtual
Globe 99 and Microsoft Internet
Explorer 4.5/5.0.

♦ Basic slide show creation
and presentation skills using
Microsoft PowerPoint 98/2000.

3 ---  4 class periods

1. Before introducing this pro-
ject to your class:

♦ Review the “Earthquake Web
Sites” listed on the first page of
the Student Activity section so
you can guide students who
are looking for specific infor-
mation.

♦ Navigate through the
Encarta Encyclopedia and
Virtual Globe articles on earth-
quakes and find related infor-

mation that your students
might want to pursue. 

♦ Ask your students if any of
them have experienced an
earthquake and would be will-
ing to describe it to the class. 

2. As a class, discuss earth-
quakes that have been in the
news. Ask the students if they
would know what to do if they
experienced an earthquake.

3. Divide the class into teams
of three to five students each,
hand out the Student Activity
pages, and start researching
quakes!
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Teacher Guide

SHAKE, 
RATTLE, AND ROLL

INTERMEDIATE REQUIRED SOFTWARE

♦ MICROSOFT® WORD 98/2000

♦ MICROSOFT® ENCARTA® DELUXE 
ENCYCLOPEDIA 99

♦ MICROSOFT® INTERNET EXPLORER 4.5/5.0

♦ MICROSOFT® POWERPOINT® 98/2000

♦ MICROSOFT® ENCARTA® VIRTUAL GLOBE 99   

SUMMARY

OBJECTIVES

PREREQUISITE SKILLS

TIME ALLOTTED

HOW TO BEGIN

Your students can learn about earthquakes generally, as well as about
specific quakes that made history, in Microsoft Encarta Encyclopedia . 



Earthquakes have fascinated
and frightened people since the
dawn of recorded history. They
can strike without warning and
cause great damage. In this
activity, you’ll learn all about
earthquakes---what they are,
what causes them, and what’s
being done to predict them and
reduce their destructive conse-
quences. You’ll investigate
some of the most famous
earthquakes ever. It’s about as
close to an earthquake as
you’ll ever get--- if you’re lucky!   

Know Your Quakes
SOFTWARE: Microsoft Word
98/2000, Microsoft Encarta
Deluxe Encyclopedia 99,
Microsoft Encarta Virtual
Globe 99, Microsoft Internet
Explorer 4.5/5.0

WHAT TO DO:

1. Open a new Word docu-
ment. You’ll use it to collect
all the information you’ll gath-
er about earthquakes. Title it
something like “Shake, Rattle,
and Roll Report” and save it
with your team name.

2. Launch Encarta
Encyclopedia and click FIND in
the menu bar to open the
PinPointer (if it’s not already
open). Type earthquake into
the PinPointer to find earth-
quake-related articles. Click on
the “Earthquake” title to jump
to the article. 

3. Scan the article to find the
answers to the following ques-
tions. Record them in your
report. 

♦ What is an earthquake?

♦ How do tectonic and vol-
canic earthquakes differ?
Which tend to be more serious?

♦ What is the Richter scale?
What does it measure? Give
some examples of Richter
scale measurements of some
famous earthquakes.

4. Launch Virtual Globe. In the
Features menu, click on
Global Themes, select
“Physical World,” then select
“Earthquakes.” Scan the
“Earthquakes” article for
answers to the following ques-
tions and include them in
your report.

♦ Explain the differences
between normal, reverse, and
strike-slip faults. Which best
describes the San Andreas
fault?

♦ What is a tsunami? How is it
formed? 

♦ When subjected to the
shock waves of a quake, soil
may undergo “liquifaction”
and behave like quicksand,
swallowing up entire build-
ings. If you knew an earth-
quake were coming, would

SHAKE, RATTLE, AND ROLL

Student Activity
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DESCRIPTION

STEP A

EARTHQUAKE WEB SITES
http://www.geo.ed.ac.uk/quakes/quakes.html - The World-Wide Earthquake Locator.
Includes maps of recent quake activity and links to FAQ and general quake information.

http://www.nd.edu/~quake/education/ - Photos, video segments, and even an earth-
quake simulation program that you can use to test different motion control systems.

http://www.crustal.ucsb.edu/ics/understanding/ - A user-friendly site with earthquake
facts, fiction, animations, and links.

http://www.abag.ca.gov/bayarea/eqmaps/eqmaps.html - An excellent site with a
Southern California focus and broader ranging relevance and links.

http://scign.jpl.nasa.gov/learn/eqact.htm - A kid approach, with a California slant.

Microsoft Encarta Encyclopedia is a good place to start your research.



you put a building on soil or
bedrock?

5. Explore the Web sites list-
ed on the previous page to
find additional earthquake
information and images.

6. Illustrate your report with
images you like.

♦ To copy images in Encarta
Encyclopedia, expand the
image, then click the down
arrow in the top of the image
frame and choose Copy from
the menu that appears.

♦ In Virtual Globe, you’ll find
the Copy > Picture command
in the Options menu.

♦ To copy images you find on
the Web, right-click on the
image and select Save Picture
As... from the menu that
appears. 

♦ Once you have saved
images to your hard disk, you
can paste them into your
Word document by going to
the Word Insert menu, click-
ing  Picture, and choosing
From File. Be sure to cite
your sources! 

What’s Shakin’?
SOFTWARE: Microsoft Word

98/2000, Microsoft Encarta

Deluxe Encyclopedia 99,

Microsoft Internet Explorer

4.5/5.0

WHAT TO DO: Now gather
information about some spe-
cific earthquakes and add it to
your report.   

1. Using Encarta Encyclopedia
and Virtual Globe, pick five
earthquakes that occurred
anywhere in the world ----  major,
minor, recent, or not so recent----

and collect the following infor-
mation about each: location,
date, duration (if given), magni-
tude, and damage. Add this
information to your report in the
form of a table. 

♦ To create a table in Word,
place the cursor where you
want the table to be, then go
to the Table menu and choose
Insert Table. Select five
columns (one for each type of
data you are collecting) by six
rows (one for each quake plus
the top row for column head-
ings), then click OK. Enter the
data into your table. If you
want to include images, insert
them them into your report
beneath the table and label
them with captions. 

2. Using Explorer, look at the
latest earthquake reports from
around the world at http://
quake.wr.usgs.gov/cgi-bin/
quake/gldfs.cr.usgs.gov .
Scroll down until you see the
map that shows where the
earthquakes occurred. With
your team, compare this map
with the map of tectonic plate
boundaries in the Virtual
Globe earthquake article. Do
the earthquakes seem to line

SHAKE, RATTLE, AND ROLL
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Microsoft Encarta Virtual Globe explains how, why, and where 
earthquakes occur. 

STEP B

EARTHQUAKE HISTORY
Historical records of earthquakes before the middle of the 18th century are gen-
erally lacking or unreliable. However, reasonably trustworthy records do exist
for the following ancient quakes: a quake off the coast of Greece in 425 BC that
created the island of Évvoia, one that destroyed the city of Ephesus in Asia
Minor in AD 17, one that leveled much of Pompeii in 63, and those that partially
destroyed Rome in 476 and Constantinople (now Istanbul) in 557 and again in
936. In the Middle Ages, severe quakes struck England in 1318, Naples in
1456, and Lisbon in 1531.1

An earthquake in 1556 in the Shaanxi (Shensi) Province of China, which killed
about 800,000 people, was one of the greatest natural disasters in history. 

1 "Earthquakes," Microsoft® Encarta® 98 Virtual Globe. © 1995-1997 Microsoft
Corporation. All rights reserved.



up with the fractures between
plates? You might want to
print out both images to make
it easier to compare them side
by side. Do your five quakes
fit the pattern?

Living with
Quakes
SOFTWARE: Microsoft Word

98/2000, Microsoft Encarta

Deluxe Encyclopedia 99,

Microsoft Internet Explorer

4.5/5.0 

WHAT TO DO: Although we
don’t know how to prevent
earthquakes, modern science
is finding better ways to predict
when and where earthquakes
will occur so that people can
be prepared. New building
designs can withstand earth-
quakes better, saving lives and
reducing damage. Using your
Encarta Encyclopedia and
Internet sources, explore the
following issues and discuss
them in your report.

1. What is seismology? How
does a seismograph work?
How is it used to help predict
earthquakes?

2. What other clues are used
to help predict earthquakes?

3. To withstand earthquakes,
buildings need to be both
strong and flexible. Read the
article on this subject at http://
quake.wr.usgs.gov/QUAKES/
FactSheets/SaferStructures .
What kind of building do you
think would be safer in an
earthquake: a wood-frame
house or a brick house? Why?

4. We can’t prevent quakes,
but we can be prepared for
them. Read the article at http://
www.abag.ca.gov/bayarea/
eqmaps/doc/youdo.html and
see what you can do. Conclude
your report with a checklist of
steps we can take to reduce
the danger and damage that
earthquakes can cause. 

Show and Tell
SOFTWARE: Microsoft Word

98/2000, Microsoft

PowerPoint 98/2000

WHAT TO DO: Now let’s make
a slide show version of your
Shake, Rattle and Roll Report. 

1. Launch PowerPoint and
select Blank Presentation.
Select a design for your show,
then start building slides.

2. Create an opening slide that
presents the name of your
show and the members of your
team. 

3. Create additional slides that
cover the major sections of
your report, including earth-
quake causes, effects, predic-
tion, and preparation. Copy
and paste text from your
report, edited to fit a more con-
cise, bulleted format for the
slides. Add images you have
collected using the Picture
command in the Insert menu. 

4. Create a slide for each of
the five earthquakes you
selected in Step B. Include
information and images you
collected in your Word table.

5. To make your slide show
livelier, you can add some
special effects. Go to the Slide
Show menu and and click on
Slide Transition for transition
and sound options. 

6. Save your presentation,
then go to Slide Show, choose
View Show, and rehearse
your presentation, using the
arrow keys to move from one
slide to the next.

6. Present your PowerPoint
show to the class.
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STEP D

STEP C

SHAKE, RATTLE, AND ROLL

Feature famous quakes in your Microsoft PowerPoint presentation.



In the dynamic setting of cur-
rent world affairs, regional
alliances are more important
than ever. And few are as
important to the United States
as the Pacific Rim: a collection
of countries that ring the
Pacific Ocean. With this les-
son, students will learn all
about the region (beginning
with the members of the Asia-
Pacific Economic Cooperation,
or APEC) while conducting
and reporting on individual
“nation explorations.”

♦ To explore the Pacific Rim
region and its countries.

♦ To present geographic and
demographic information in a
catchy and informative way.

♦ Basic library research skills.

♦ Essential grasp of world
geography.

♦ Practice at presenting ideas
and information using
Microsoft Word 98/2000 and
Microsoft PowerPoint 98/2000.

2 ---  3 class periods

1. Open Microsoft Word and
type all the names of Pacific
Rim countries shown in the
box in the Student Activity. 

2. Select all of the names and
use the Formatting toolbar to
increase the type size to 18.
Double space between names,
and print out.

3. Cut the names apart so that
each is on a horizontal slip of
paper. Roll each slip of paper
into a scroll and tie with a
small ribbon or piece of string.

4. Place scrolls in a blue bowl,
bin, or box (representing the
Pacific Ocean).

5. Find a map of the Pacific

Rim to display on the wall of
your classroom.

6. Determine the cardinal
directions ---- north, south, east,
and west ---- in your classroom,
and post signs to indicate them.

7. Divide your class into
enough one- and two-person
teams to cover all the Pacific
Rim nations. 

8. Set up your classroom com-
puters for easy access by the
teams.

9. Tell kids that they are about
to explore one of the world's
most fascinating and diverse
regions: those countries on
whose shores lap the Pacific
Ocean ---- otherwise known as
the Pacific Rim.
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Teacher Guide

AROUND THE 
PACIFIC RIM

INTERMEDIATE REQUIRED SOFTWARE

♦ MICROSOFT® WORD 98/2000

♦ MICROSOFT® POWERPOINT® 98/2000

♦ MICROSOFT® INTERNET EXPLORER® 4.5/5.0

SUMMARY

OBJECTIVES

PREREQUISITE SKILLS

TIME ALLOTTED

HOW TO BEGIN

Your students will explore the nations that ring the Pacific Ocean.

The Pacific
Rim 



You're about to set off on a
journey of discovery around
the world's greatest ocean:
the Pacific. You'll start off by
learning all about one country
touching the Pacific, and end
by knowing many!

Circle the Rim
SOFTWARE: None

WHAT TO DO: In this step,
you will convene with your
team, select a country, and
begin getting your geographic
bearings.

1. Choose one of the scrolls
out of the bowl your teacher
has prepared. The country
named on your scroll will be
your focus for the first part of
this project.

2. Find your chosen country
on the Pacific Rim map. Notice

its position according to the
cardinal directions (north,
south, east, west).

3. At your teacher’s signal,
assemble with your classmates
in a circle around the class-
room in the same order as the
nations around the Pacific Rim.
Hold up your scroll, and
acknowledge both your imme-
diate neighbors and those
from across the sea.

Virtual Rim
SOFTWARE: Microsoft

PowerPoint 98/2000

WHAT TO DO: Now your
whole class will collaborate on
a PowerPoint “map” that will
soon link to every group’s indi-
vidual country presentation.

1. Launch PowerPoint, open a
new presentation, choose
Blank Presentation, and
select Blank slide layout. 2. Next, go to View on the

menu bar and choose the
Drawing toolbar.

3. Select the oval tool, and
draw an oval in the center of
the slide. This will serve as a
graphic stand-in for the
Pacific. Double-click on the
oval, select Fill and choose
just the right shade of blue.

4. Click on AutoShapes,
choose Callouts, and select a
callout you can use to desig-
nate each  Pacific Rim nation.
Duplicate callouts and place
them in the countries’ relative
locations. To work on the
opposite side of the oval, go
to the Draw menu and choose
Rotate or Flip.

AROUND THE PACIFIC RIM

Student Activity
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DESCRIPTION

STEP A

STEP B

Microsoft PowerPoint makes it easy to create a colorful display of
the Pacific Rim countries in their relative locations around the
Pacific Ocean. 

NATIONS OF THE 
PACIFIC RIM*

Australia

Brunei

Canada

Chile

China

Indonesia

Japan

Malaysia

Mexico

New Zealand

Papua New Guinea

Philippines

Singapore

South Korea

Taiwan

Thailand

United States

* Members of Asia-Pacific Economic
Cooperation, or APEC. What other

nations touch the Pacific?



5. Now label your country’s
callout by clicking in the middle
and typing the country name.
To change fill color or pattern,
double-click the callout to open
the Format Autoshape dialog
box. Choose the Colors and
Lines tab, click the list button
in the Fill box, and choose a
color or the More Colors... or
Fill Effects... options. You can
even change the shape and
style of the callout by going to
the Drawing toolbar, selecting
Draw, then Change Autoshape,
and picking a different callout.

Nation
Exploration
SOFTWARE: Microsoft Word

98/2000, Internet Explorer

4.5/5.0

WHAT TO DO: In this
research phase, you and your
teammates should approach
your country of focus as if
you were explorers on an
expedition. 

1. Open a new Word docu-
ment in which you can type
facts you’ll find in your library
research, and in which you
can paste maps and photos
you’ll find on the Internet or
in other electronic sources.

2. Consult sources such as
the World Almanac for popula-
tion statistics and key eco-
nomic indicators (such as
gross national product). 

3. Look through print and
electronic atlases for geo-
graphic features and points of
interest. Copy the best elec-
tronic maps and photos and
save them as bitmap (.bmp)
files. In your Word document,
go to Insert > Picture and
select these maps and photos.

4. Find a graphic of your
nation’s flag, and save it to
insert into your Word docu-
ment as you did in Step C-3.

5. Explore your nation’s histo-
ry in relation to the other
Pacific Rim countries. Is there
a tradition of trade and cultur-
al exchange between your
country and some others in
the region? Of immigration? Of

warfare and conflict? Summarize
these in your Word document.
Be sure to cite your sources.

6. The Pacific Rim countries
are constantly in the news.
Use the Reader’s Guide to
Periodical Literature and the
Internet to find recent news
stories involving your country
of focus. Summarize these in
your Word document, being
certain to cite your sources. 

7. Look for information that
helps you understand what
daily life is like in your coun-
try. In your Word document,
write a paragraph about a day
in the life of a made-up family
(with a name common in your
country). Include information
about the jobs the parents
might have, what the kids do
in school and out, what the
family’s home is like, and so on.

8. Now, based on what you
know about your nation, create
a sign for your location in the
classroom. In your Word docu-
ment, Insert Picture, and
choose WordArt. Select a style
and type the name of your
country. 

AROUND THE PACIFIC RIM
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STEP C

The Asiaville page
(http://www.asiaville.
com/index2.html ) is
one of many Web
sites that can help
you find information
about your Pacific
Rim country. You’ll
find links to a wealth
of facts and photos,
like this image of
Brunei schoolchildren
from http://www. 
lonelyplanet.com/
dest/sea/graphics/
brun01.htm.

Gather images and information
about your Pacific Rim country
in a Microsoft Word document.



Create a Kiosk
SOFTWARE: Microsoft

PowerPoint 98/2000,

Microsoft Word 98/2000

WHAT TO DO: Now you’ll
translate all your research into
a PowerPoint kiosk --- an interac-
tive display your classmates
can browse on their own. 

1. In PowerPoint, go to File
and choose New. You can then:

♦ Click on the Presentation
tab, and select an interesting
design.

♦ Click on the General tab and
choose Blank Presentation to
create your own design. For
example, you may want your
nation’s flag to appear at the
top of every slide, or its map
to appear as a background.
After you have opened the
presentation, go to View,
Slide Master, and position

these elements as you choose.
Go to Format, scroll down to
Slide Color Scheme or
Background, and make fur-
ther design choices. Then
Close Slide Master.

2. Now begin creating slides
using the information you col-
lected in Step C. Open your
Word document, and where
possible simply highlight text
or other elements, then Copy.
Paste them into your
PowerPoint slides. For example:

♦ In PowerPoint, Insert a New
Slide, and in the Autolayout
box, choose the Title Only.
Go back to your Word docu-
ment, select the WordArt ver-
sion of your country’s name,
Copy it, and Paste it in the
Title area of your PowerPoint
slide.

♦ For slides providing statisti-
cal background information
about your country, such as
population and education,

Copy and then Paste the data
you gathered in Step C-2.

♦ Use the pictures and graph-
ics you collected in Step C by
either copying them from
your Word document or, in
PowerPoint, using Insert >
Picture > From File, and
selecting the picture or graph-
ic directly from the file you
created while working on your
Word document.

♦ Expand on your “day in the
life” paragraph from Word to
create several slides that fol-
low your typical family’s day.
Be sure to include pictures.

3. When all your slides are
complete, go to View, and
then choose SlideSorter. Go
to the Slide Show menu, and
add Slide Transitions. Specify
the speed of each transition,
and select the on mouse click
option in the Advance box.
Click View > Show, and click
through your presentation to
see how well your transitions
serve your material. Save your
work.

4. Go back to the “map” you
created in Step B and select
your country’s callout. Go to
Slide Show, choose Action
Buttons, and create a
Hyperlink to your country
presentation. 

5. After all of the teams have
finished their work, go with
your team to the computer,
and browse through the 
presentation on each country.
You might even want to invite
other classes in to discover the
Pacific Rim through the multi-
media kiosk you’ve created!

AROUND THE PACIFIC RIM
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STEP D

Turn your research into an interactive presentation with Microsoft
PowerPoint.



In today’s global marketplace,
intellectual property is a hot
commodity --- and a concept
sometimes lost on consumers
of all ages. As a result, thieves
of intellectual property (also
known as “pirates”) counterfeit
a dizzying array of merchan-
dise, from software to toys to
sneakers. As consumers, your
students need to understand
what intellectual property is
and how to safeguard them-
selves against fakes. This pro-
ject provides a fun, kid-sized
introduction to these concepts.

♦ To understand the concept
of intellectual property and
identify ways to overcome 
piracy and counterfeiting. 

♦ Basic computer skills.

♦ Research skills using library
and Internet resources.

4 class periods and ongoing

1. Call your class together, and
ask: Should someone be able to
“own” an idea? Call for a show
of hands, yes or no. Then pose

the question this way: What if
the idea took the form of an
invention? A song? A design?
What rights should the person
have who came up with the
idea? What protections should
there be for the original idea?

2. Introduce the concept of
intellectual property in an age-
appropriate way:

♦ Assign older students to use
the dictionary, library
resources, and the Internet to
develop a working definition of
intellectual property, with 
examples of what it is and how
it’s protected in key fields such
as fashion and technology.

♦ Assign younger students to
find out who “invented” their
favorite toy, cartoon, or song.

Have them use the library and
the Internet to explore how
their favorites came to be --- and
what keeps them unique.

3. Next, take your students
online to one of the Web sites
listed on the Student Activity
page. While they’re reading
through the warnings about
counterfeiting, pose these
questions: What’s so bad about
this kind of copying? Who
cares whether what you buy is
the real thing or a fake? Expect
some heated discussion!

44..  Together, develop a list of
fields that particularly attract
counterfeiters (also known as
pirates) and where those
pirates might sell their wares.
Then divide the class into small
groups for the Student Activity.  
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Teacher Guide

WHAT�S THE REAL DEAL?

SPECIAL CLASS PROJECT:

INTELLECTUAL PROPERTY
FOR YOUNG CONSUMERS

(ALL GRADE LEVELS)

SUMMARY

OBJECTIVES

PREREQUISITE SKILLS

TIME ALLOTTED

HOW TO BEGIN

REQUIRED SOFTWARE

♦ MICROSOFT® WORD 98/2000

♦ MICROSOFT® POWERPOINT® 98/2000

♦ MICROSOFT® INTERNET EXPLORER 4.5/5.0

♦ MICROSOFT® PUBLISHER 98/2000

Counterfeiting affects a wide array of fields your students care about.



Is that CD  you’re spinning “the
real deal?” How about bean-
bag toy you just added to your
collection or that designer
shirt you’re wearing? There’s a
booming market in stolen
ideas and illegal copies these
days.  To be a smart shopper,
you  need to be aware of coun-
terfeits, knock-offs, and fakes ---
not to mention the modern-day
“pirates” who create them!
With this class project, you’ll
investigate just how big a
problem counterfeiting really
is, why you should care, and
how to fight back.

Find the Fakes
WHAT TO DO: Piracy takes
many different forms in differ-
ent fields. In this step, your
team will explore the problem
in one particular field.

1. Gather with the team your
teacher has assigned you to,
and choose a field of focus,
such as music, toys, publish-
ing, or software. Discuss the
examples of counterfeiting you
might have personally encoun-
tered. Did anyone ever copy a
favorite software program for
you? Ever see Chicago Bulls
jerseys so cheap you just knew
they must be fake? Make a list
of the many ways pirates might
work in your field of focus.

2. Now go to the library and
to the Internet to track down
news reports and statistics
about counterfeiting in your
field (see box at left for leads).
In particular, look for informa-
tion about:

♦ Τhe volume of fake mer-
chandise produced.

♦ Where and when these
fakes are most likely to be
sold (such as online, on the
street, or through stores).

♦ The financial impact on con-

sumers, the industry, and the
economy as a whole.

♦ Common types of piracy in
this field and how to spot them.

♦ Problems that piracy causes
for end-users (such as inflated
prices or merchandise that
doesn’t work right).

♦ How piracy affects the origi-
nal creators --- musicians, soft-
ware developers, game design-
ers, and so on.

♦ Law enforcement action
against fakes.

Keep a list of your facts to use
in the following steps.

Reality Check
WHAT TO DO: Translate what
you’ve learned about counter-
feiting into a fact sheet alerting
other kids to the problem.

1. With your team, discuss
your various research results

WHAT�S THE REAL DEAL?
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DESCRIPTION

STEP A

STEP B

REAL-DEAL WEB SITES

Microsoft �Be Sure It�s Legal�
Protection Against Software Piracy
(http://www.microsoft.com/piracy)
Facts about piracy in the computer soft-
ware field, and what you can do to fight it.

The International AntiCounterfeiting
Coalition
(http://www.ari.net/iacc/home.html)
A clearinghouse site on piracy and 
counterfeiting. Includes areas such as
Facts on Fakes (including economic
impact), Museum of Fakes, and The Law.

Beanie Babies (http://www.ty.com/) 
The official Beanie Babies site has a
Guestbook area (http://www.ty.com/fastc-
gi/viewguest.fcgi) that warns about the
prevalence of fakes.

DID YOU KNOW?
27% of all software in use in the U.S. is illegally copied.

HOW SOFTWARE PIRACY HAPPENS:

1. Cool program, can I �borrow� it?
Copying software is against the law unless you have permission 

from the software maker.

2. It came with my computer.
Unscrupulous computer-sellers sometimes install software illegally.

3. Not quite the real thing.
Counterfeiting operations turn out knock-offs of software programs-- 

often without important user information, and sometimes with bugs or viruses.

4. For you, a special price.
Dealers sometimes improperly make special discounts meant for certain kinds

of customers -- like schools -- available to others who don�t qualify.

Present the facts you discover about “piracy” in your field of focus.



from Step A. Which aspects of
piracy in your field will seem
most important to kids your
age? 

2. Create a fact sheet with
Microsoft Word to collect your
most compelling facts.
Rephrase your points in 
language kids will pay attention
to, and add graphics for
impact. 

3. Share your fact sheet with
the class either by printing
and distributing it or by giving
a presentation.

4. Read or listen to the other
groups’ facts, and discuss simi-
larities and differences among
fields when it comes to piracy. 

Fighting the 
Good Fight
WHAT TO DO: Build on your
work in Step B to develop a
campaign against piracy in
your field and others. Here are
some ideas you might want to
try:

1. Create a Top 10 list, David
Letterman-style. For example,
you might want to tackle “Top
10 Signs You’ve Got Bootleg
Software” or “Top 10 Ways a
Pirated Video Can Ruin Your
Evening.”  (Remember, even
though the subject is serious,
your Top 10 list should be
funny, because the most
important points can some-
times be made through
humor.) With the help of your
classroom computer, turn
your Top 10 list into a paper
handout, a presentation, or a
Web page.

2. Develop a slogan that cap-
tures your anti-piracy mes-

sage in one easy-to-remember
phrase. Your groups should
brainstorm several slogans
and then pick a favorite.

3. Create anti-piracy
reminders that your class-
mates will see every time they
use their computers by turn-
ing your slogan into “wallpa-
per” or a screen saver. To do
this, use Microsoft Publisher or
Microsoft PowerPoint to create

a catchy layout with your slo-
gan and some art, then use
the PrintScreen  or “screen
snapshot” function on your
computer to “take a picture”
of your computer screen. You
can then import this picture
into a graphics accessory
such as Paint and save it as a
bitmap, which can then
become wallpaper or a screen
saver.

WHAT�S THE REAL DEAL?
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STEP C

TOOLS TO USE FOR THIS PROJECT
Microsoft Word 98/2000: Collect your piracy
research notes --- even photos and graphics --- to write
up as a report or publish as a Web page.

Microsoft PowerPoint 98/2000: Turn your
research into a persuasive presentation, complete
with sound effects and animation.

Microsoft Internet Explorer 4.5/5.0: Use the
Internet to find out all about modern-day pirates.

Microsoft Publisher 98/2000: Spread the word
with brochures, banners, newsletters, and more.

Plan a kids’ campaign against piracy in your own field of focus. 



4. Wrap up by thinking of
some “big ideas” for getting
your anti-piracy message
across. Imagine that you have
a million-dollar budget. What
high-impact ideas might your
group have for reaching young
people with an anti-piracy 
message? Would you create a
TV ad campaign, build a
school Web site, launch a
blimp, run a contest? Decide
together on your three best
ideas, and create a PowerPoint
presentation that  explains
each idea. Explain your strate-
gy and include mock-ups of
slogans and art. Then present
your campaign to the class.

Setting the Stage
For the Real Deal 
WHAT TO DO: Now your
class’s challenge is to take
your anti-piracy message to
the world outside your school
in a way that parents, neigh-
bors, and local businesspeo-
ple can really understand. A
play’s the thing!

1. Bring your small groups
together as a class. Have each
group summarize the high-

lights of what it discovered in
Steps A--C, and how group
members feel about what they
learned about piracy in their
chosen field. What’s the one
thing they would most want
the general public to know
about this topic?

2. Next, each group should
make up a five-minute skit 
dramatizing the problem of
piracy in its particular field.
To keep the skits fresh and
fun, try an approach like one
of the following:

♦ Show the perils of counter-
feiting from the point of view
of a product: What if you were
a real Beanie Baby that some-
one was trying to make illegal
copies of? How might you play
if you were a pirated comput-
er game?

♦ Make up a super-heroine
(or hero) character called The
Piracy Buster, and dramatize
this character’s exploits in
fighting fakes.

♦ Create list of smart tips for
consumers to guard against
counterfeit merchandise --- and
then present it as a rapping
rhyme. Be sure to credit any
music “samples” you use!

♦ Take your audience on a

tour of a “pirate’s den” show-
ing how knock-offs are pro-
duced (and what dangers they
pose for consumers).

♦ Use the form of an animal
fable --- like those of Aesop --- to
explain why “making a copy
for a friend” can also be a
form of piracy.

3. Your group should show
the class a “rough cut” of your
skit, and ask for feedback on
how to improve or clarify it.

4. Each group should desig-
nate a member to the publici-
ty committee to set a date or
dates for the performance and
start getting the word out to
families and the community.

5. Each group should also
designate one member to be
part of a production team to
write an introduction to the
series of skits, arrange the
order in which the skits are
presented, plan for any need-
ed scenery or props, and set a
rehearsal schedule leading up
to opening night. 

6. When the big debut comes,
break a leg! (That means
“good luck” in theater lingo.)
You’ll already be doing your
part to break the piracy trend.

WHAT�S THE REAL DEAL?

Productivity in the Classroom 23Find more great lessons at: www.microsoft.com/education/curric/activity

STEP D

The publicity committee can use Microsoft Publisher to spread the word about your anti-piracy plays.
Make banners to hang in the hallways, then create invitations, a playbill, and more!



On June 19, 1865 ---  more than
two years after the
Emancipation Proclamation ---
the word that they were free
finally reached slaves in
Texas. This day is now com-
memorated in African
American communities across
the country as Juneteenth, a
special kind of Independence
Day. In this project, your stu-
dents will explore Juneteenth
and document it in a multime-
dia encyclopedia entry.

♦ To understand the historical
context of the end of slavery
and its commemoration.

♦ Introduction to Microsoft
Encarta Africana.

♦ Ability to write and edit
using Microsoft Word 98/2000.

♦ Internet skills using Microsoft
Internet Explorer 4.5/5.0.

3 class periods

1. Gather the books listed in

the box in Step B of the
Student Activity, and add the
Web sites listed there as
Favorites in Explorer.

2. If you do not yet have access
to Encarta Africana, your stu-
dents can use Encarta

Encyclopedia for some of their
research on slavery, the Civil
War, and emancipation. Useful
articles include “African
American History,” “Civil War,
American,” and “Texas, History.” 

3. Ask your class: When was
slavery abolished in the United
States? Write their guesses on
the board. Then ask: When and
how might slaves in different
parts of the country have
heard that they were free? How
might they have reacted?

4. Tell students that they are
about to discover a special day
celebrated by people across
the America to commemorate 
freedom from slavery.
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Teacher Guide

DISCOVERING
JUNETEENTH

MIDDLE SCHOOL REQUIRED SOFTWARE

♦ MICROSOFT® ENCARTA® AFRICANA

♦ MICROSOFT® WORD 98/2000

♦ MICROSOFT® INTERNET EXPLORER 4.5/5.0

SUMMARY

OBJECTIVES

PREREQUISITE SKILLS

TIME ALLOTTED

HOW TO BEGIN

Microsoft Encarta Africana documents African American slavery and
freedom with source materials like this painting of a slave auction.



Imagine how you might feel if,
after a lifetime of being held
against your will, you were set
free --- and you might come
close to understanding the ori-
gins of Juneteenth, also known
as the African American
Independence Day.  In this pro-
ject, you’ll study the history of
Juneteenth, explore how it’s
celebrated today, and then
help spread the word about
this important holiday. 

From Slavery to
Freedom
SOFTWARE: Microsoft
Encarta Africana, Microsoft
Word 98/2000

WHAT TO DO: The history of
slavery in the United States
and its eventual abolition is
complex. Your first task is to
explore the chronology of
these events surrounding slav-
ery: the secession of slave-
holding states (including
Texas) from the Union; the

unfolding of the Civil War;
President Abraham Lincoln’s
Emancipation Proclamation,
which freed slaves in the
Confederate states; and the
Thirteenth Amendment to the
Constitution, which abolished
slavery in the reconstituted
United States.

1. Launch Encarta Africana.
(Note: If you are not using
Encarta Africana, your teacher
will help you find much of the
following information in
Encarta Encyclopedia.) 

♦ On the opening screen of
Encarta Africana, choose
Timeline. 

♦ Click on “Exploring Africa,
Exporting Africans, 1500--1799.” 

♦ As the timeline scrolls by,
select “Transatlantic Slave
Trade (1510--1867)” and read
the article about the deploy-
ment of slave labor in the New
World. 

♦ In the Related Articles box,
select “Slavery in the United
States.” 

♦ Begin selecting key dates for
your own chronology of slav-
ery and freedom. Open a new

Word document to copy and
paste these dates into, along
with any relevant graphics.

2. Next, scroll ahead in the
Encarta Africana timeline to
“Abolition and Emancipation,
1800--1899.” Search for key
dates and images to complete
your chronology. Pay particu-
lar attention to the timing of
Civil War events and the
Emancipation Proclamation.

3. In your Word document, go
to View > Toolbar > Drawing,
and use the drawing tools to
organize your dates, facts, and
graphics into a visual chronol-
ogy. The Autoshapes >
Flowchart function might
prove especially helpful, along
with the arrow tool. 

4. Insert the date June 19,
1865 into your chronology.
This is the date when slaves in
Texas first heard (from Union
Army officials landing in the
port of Galveston) that they
were free.  How does this date
relate to the Emancipation
Proclamation and the end of
the Civil War?  What are some
reasons you can think of for
the gaps among these dates? 

DISCOVERING JUNETEENTH

Student Activity
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DESCRIPTION

STEP A

The Emancipation Proclamation 
By the President of the United States of America: 

A Proclamation

"...That on the first day of January, in the year of our Lord one
thousand eight hundred and sixty-three, all persons held as
slaves within any State or designated part of a State, the people
whereof shall then be in rebellion against the United States,
shall be then, thenceforward, and forever free...�

-- From “The Emancipation Proclamation" 

Use Microsoft Encarta Africana to research important milestones in slavery and freedom in the U.S.



Juneteenth, 
Then and Now
SOFTWARE: Microsoft
Internet Explorer 4.5/5.0,
Microsoft Word 98/2000,
Microsoft Encarta Africana

WHAT TO DO: According to
legend, slaves in Texas
marked their belated emanci-
pation on June 19, 1865, with
a celebration that has come to
be known as Juneteenth. Now

you’ll find out more about this
unique “Independence Day”
celebration.

1. Seek out the books and Web
sites listed in the box on this
page.  Read about the history of
Juneteenth and follow the Web
links to discover how it’s cele-
brated across the country.

2. Open your Word document
from Step A, and add the notes,
Web addresses, and graphics
you’ll  find on the Web and in
print resources related to
Juneteenth.

Rounding Out 
The Record
SOFTWARE: Microsoft
Encarta Africana, Microsoft
Internet Explorer 4.5/5.0,
Microsoft Word 98/2000

WHAT TO DO:

1. Open Encarta Africana,
click on Articles, go to Find,
and use the PinPointer tool to
locate the article entitled

“Festivals in the United
States.” Read about the cele-
brations held by free African
Americans and white aboli-
tionists before the Civil War to
promote emancipation
throughout the Americas.

2. Print the “Festivals in the
United States” article. Use it as
a model for your own encyclo-
pedia entry about  Juneteenth.

3. Open a new Word docu-
ment, and set it up to resemble
the Encarta Africana format:

♦ Go to Insert > Text Box.
Click on the box and drag it to
cover most of the page. Go to
Format > Text Box, choose
Fill, and select a fill color
and/or texture that suits your
subject. 

♦ Go to Insert > Text Box,
and add a box that covers the
right side of the page, as the
text does in Encarta Africana.
Add a complementary light
color, pattern, and/or texture. 

♦ Write an encyclopedia entry
describing Juneteenth, using
the notes you took in Step B.

♦ Where appropriate, insert
hyperlinks to connect your
article to relevant Web sites
you’ve found.

♦ Add graphics to the left side
of your page (including your
visual chronology from Step A)
by copying and pasting from
your original Word document.
Be certain to cite your sources!

4. When your Juneteenth arti-
cle is complete, print it out and
proofread it carefully. Then:

♦ Display it on a bulletin
board in your classroom.

♦ Save it as an HTML file to
post on your school intranet.

DISCOVERING JUNETEENTH
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STEP C

STEP B

JUNETEENTH RESOURCES

Juneteenth.com Worldwide
Celebration (http://www.juneteenth.com):
Background information, state/internation-
al celebrations, and more 

The National Juneteenth Museum
(http://www.x-change.com/juneteenth/
info.html): History and art

Juneteenth -- Freedom Day by Muriel
Miller Branch (Cobblehill, 1998)

Juneteenth by Ralph Ellison and John F.
Callahan (Random House, forthcoming
June 1999)

Write your own encyclopedia article about Juneteenth festivities.



Thanks to technology, we live
in era of instant, constant
access to the news --- much of
it of the tabloid, sensationalis-
tic variety. How do the media
affect the message? Do jour-
nalists have special responsi-
bilities in a digital age? With
this lesson, students will
explore some of the ethical
issues facing today’s journal-
ists and compare and contrast
the ethics of publishing on
paper versus cyberspace.
Then they’ll try their hand at 
creating an online publication. 

♦ To understand and evaluate
the ethical foundations of 
modern journalism. 

♦ To use tools such as the
Internet, e-mail and print to
gather information.

♦ To develop news stories that
follow ethical standards.

♦ Ability to write and edit
using Microsoft Word 98/2000.

♦ Basic use of the Internet.

♦ Introduction to Web page
design using Microsoft
FrontPage 98/2000.

8 class periods

1. Assign your student to
working groups of 4--- 6 students
each. Be sure that each group
includes at least one student
who has the language skills
and computer expertise to
guide others in creating an
online news publication.

2. As a class, discuss how your
students perceive the news
media and the profession of
journalism. Do students usually

believe what they read in the
newspaper or see on TV news?
Why or why not? Do they trust
some sources more than oth-
ers? Why? How important is it
that America has a free press?

3. Ask your students: What are
your biggest complaints about
the news media today? If you
were addressing a convention
of journalists from all over the
world, what three things would
you tell them to do differently?

4. Tell students that they will
now have the opportunity to
explore the ethical dilemmas
that journalists face in today's
world, and then gain hands-on
practice at journalism in the
digital age.

Teacher Guide

NEWS AND ETHICS 
IN THE DIGITAL AGE

MIDDLE SCHOOL/
HIGH SCHOOL

REQUIRED SOFTWARE

♦ MICROSOFT® INTERNET EXPLORER 4.5/5.0

♦ MICROSOFT® WORD 98/2000

♦ MICROSOFT® FRONTPAGE® 98/2000

SUMMARY

OBJECTIVES

PREREQUISITE SKILLS

TIME ALLOTTED

HOW TO BEGIN
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Journalists face new challenges and new opportunities on the Internet. 



Journalism involves more
than simply finding facts and
writing them down. Reporters
face difficult ethical questions
every day: How do I balance
one person's privacy against
the public’s need to know?
Can I trust this source? How
do I know when "the facts" are
solid enough to publish? In
this activity, you'll explore all
those questions and more.

What Are News
Ethics?
SOFTWARE: Microsoft
Internet Explorer 4.5/5.0,
Microsoft Word 98/2000

WHAT TO DO: Here's where
you and your working group
get up to speed on the princi-
ples that reporters are sup-
posed to be guided by.

1. Gather in your team as
assigned by your teacher.
Launch Explorer and go to
http://csep.iit.edu/codes/
media.html to find the
"Statement of Principles” of the
American Society of Newspaper
Editors posted there.

2. As a group, discuss the fol-
lowing questions:

♦ Since the First Amendment
protects freedom of expres-
sion, should newspapers or
other forms of news media be
able to print anything they
want?  Why or why not?

♦ Have you ever read in a
newspaper, seen on TV, or
heard on radio, news which

you felt should not have been
made public?  Give some
examples and explain why.

♦ How might newspapermen
and women abuse their power?

♦ How does the American
press serve to keep a watch
on public services such as
schools, businesses, stores,
and government agencies?

♦ How might a journalist com-
promise his/her integrity?

3. Open a new Word document
and compose written answers
to the questions you discussed
above. Title this document
"Journalistic Ethics Statement,"
followed by the names of the
students  in your group. Print
out your document, or display
it on the computer screen, so
the other groups can review
your thinking while you do the
same with theirs. Do all the
groups generally agree or dis-

agree? Why? Discuss the ques-
tions as a class. 

Digital Ethics
SOFTWARE: Microsoft
Internet Explorer 4.5/5.0,
Microsoft Word 98/2000

WHAT TO DO: How have 
computers, satellites, and the
Internet have changed the
journalism business? Are "new
media" outlets such as Web-
based magazines and e-mail
news services governed by
the same ethics that govern
traditional journalists? Your
group will grapple with these
questions now. 

1. As a group, check out a
variety of Internet-based news
sites, including those listed in
the box on the next page. 

2. Discuss the differences

NEWS AND ETHICS IN THE DIGITAL AGE

Student Activity
DESCRIPTION

STEP A
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STEP B

Use Microsoft Word to craft a code of ethics for today’s journalists.



between reading about a news
event online, reading about it
in a newspaper, and watching
a TV news report. 

3. Go to the article, "Online
Journalism Ethics: A New
Frontier" from the American
Society of Newspaper Editors,
at http://www.asne.org/kiosk/
editor/november/byrd.htm.
The writer raises thought-
provoking questions for your
group to discuss.

4. Open your group's
"Journalistic Ethics Statement"
Word document, and add to or
revise the guidelines you've
developed to include technolo-
gy-based new media as well.

5. Finalize your ethics state-
ment to reflect all you've
learned in Steps A and B, and
save it as a separate Word
document. Print the document
and provide a copy to each
student in your group.

Ethics
International
SOFTWARE: Microsoft
Internet Explorer 4.5/5.0,
Microsoft Word 98/2000

WHAT TO DO:

1. Launch Explorer and go back
to the http:// csep.iit.edu/
codes/media.html site you visit-
ed in Step A. In consultation
with your teacher, choose one
of many statements of news
ethics listed here from coun-
tries around the world.

2. With your group, discuss the
similarities and differences you
see between the American
Society of Newspaper
Journalism's "Statement of

Principles" and the ethics posi-
tion of the country you're
focusing on.

3. Open your group's
"Journalistic Ethics Statement"
Word document and insert a
page break. Write a paragraph
or two on a new page compar-
ing and contrasting the two
nations' news ethics guidelines.
Title this page "International
Perspectives." Save your docu-
ment, and print out or display
for other groups to read. 

4. Read other groups'
“International Perspectives”
pages, and discuss as a class.
What surprised you most? Why? 

Case Studies
SOFTWARE: Microsoft
Internet Explorer 4.5/5.0,
Microsoft Word 98/2000

WHAT TO DO:

1. As a group, develop a list
of the top ten news stories
from the past year or so.
These can be international,
national, or local, just as long
as they got your attention.

2. Meet as a class and com-
bine lists. Each group should
then choose a different story
to explore as a case study. 

3. For your case study, collect
as many different versions of
your story as you can find.
Use the Internet as your start-
ing point: check out the Web
sites of the relevant newspa-
pers and magazines (including
some international ones) and
see if the TV news sites pro-
vide coverage. Also look for
other Web sites that followed
the story as unofficial news
outlets; these might range
from widely read online

newsletters like the Drudge
Report to gossip sites on hot
news topics. Choose three
versions of your story from
three of these "news outlets"
to compare and contrast. 

4. Open a new Word docu-
ment, go to Table, and select
Insert Table. Make your table
three columns by  four rows
(you may insert additional
rows later). Label each col-
umn for one of the news out-
let you chose. Label the rows
Tone, Key Facts, Major
Sources, Other, and Ethics
Grade. 

5. As your group analyzes the
different versions of your news
story, begin filling in the cells
with your observations about
how each news outlet handled
the story. Look for ways that
the ethical standards you
explored in Steps A and B were
or were not applied by the

STEP C
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NEWS AND ETHICS IN THE DIGITAL AGE

JOURNALISM SITES

CODES OF ETHICS

Illinois Institute of Technology/
Codes of Ethics Online: Media
(http://csep.iit.edu/codes/media.html)
Choose from an index of more than
30 countries and many large U.S.
newspapers.

NEWS OUTLETS

The Wire -- News from the
Associated Press (http://wire.ap.org)
Top stories from the leading news 
service.

MSNBC (http://www.msnbc.com)
Round the clock cable news and Web
coverage.

The Drudge Report
(http://www.drudgereport.com)
Online news and gossip, with lots of
links to conventional media.

STEP D



journalists covering the story.
Think in particular about situa-
tions in which the speed and
power of the electronic media --
such as the Internet or televi-
sion ---  played a role in the ethi-
cal dilemma. 

6. If possible, contact either
the news outlets or the
reporters who covered the
story to do "behind the scenes"
interviews. Use e-mail to ask
such questions as: Why was
this story important? Do you
feel the public got all the facts?
How did you choose what to
include and what to leave out? 

7. When your analysis is com-
plete, give each of your news
outlets an “Ethics Grade” of A
to F based on the your group’s
ethics statement.

8. Print out your comparison
table, and display it with the
different versions of your case
study news story. Circulate
around the classroom and read
the other groups' case studies.

Make Your Own
News
SOFTWARE: Microsoft Word
98/2000, Microsoft
FrontPage 98/2000,
Microsoft Internet Explorer
4.5/5.0 

WHAT TO DO: Now’s your
chance to apply your ethics
statement to the real world of
journalism by publishing your
own online news reports.

1. Designate one of your
group members as managing
editor. In addition to keeping
your group’s work organized,
this student should have or
develop skills in creating Web
pages using FrontPage.

2. Meet as a group to propose
several school-based or local
story ideas for the publica-
tion. Each student should
then choose one story to pur-
sue (or you can work in pairs,
if your group is large enough).

3. As you research and write
your story, keep your group’s
ethics statement in mind. 

4. When you have a rough
draft, trade with another
reporter for feedback. Fine
tune and revise as needed. 

5. When all of the second
drafts are complete, meet as a
group to discuss how well they
meet the standards set in your
ethics statement. Revise as
needed.

6. Next, meet as a group to
discuss a basic layout for your
Web page, including the order
in which stories appear, pho-
tos and clip art, if appropriate.

Discuss some of the online fea-
tures suggested in the "Online
Journalism Ethics" story you
read in Step B, such as bulletin
boards for readers to post
their own views, links directly
to your sources (with their
permission) and sidebars that
give additional background
information or varying view-
points. Decide where and how
your group’s ethics statement
should appear on your Web
site.

7. Together with your group’s
managing editor, create your
Web site in FrontPage. Open a
document, choose a template,
create your home page, import
your story texts, add art and
photos, and create links. 

8. Invite the other groups and
your teacher to "test drive"
your Web site before it is post-
ed to your school's intranet or
to the Internet.

STEP E

30  Productivity in the Classroom Find more great lessons at: www.microsoft.com/education/curric/activity

Microsoft FrontPage lets you create your own online news site.

NEWS AND ETHICS IN THE DIGITAL AGE



In the spring, many students’
thoughts turn to... baseball.
This lesson uses baseball to
teach the fundamentals of
aerodynamics in a way that
every student will enjoy. By
experimenting with wind tun-
nel simulation software, stu-
dents will learn about the
forces that give airplanes their
lift and curveballs their curve.
A curveball contest will let
students put their aerodynam-
ic insight to the test.

♦ To provide an introduction
to principles of aerodynamics.

♦ To let students experiment
with the variables that affect
lift and see instant results.

♦ To make aerodynamics fun
by applying it to an activity
every student can relate to.

♦ Research skills using
Microsoft Encarta Deluxe
Encyclopedia 99.

♦ Practice at creating spread-
sheets in Microsoft Excel
98/2000.

2 -- 3 class periods

1. Before the first class, down-
load the FoilSim program from
http://www.lerc.nasa.gov/
Other_Groups/K-12/aerosim
and install it on the students’
computers. Consult the
FoilSim Readme file if you
need help with installation.
FoilSim is freeware, as
described in the copyright
notice on the site. See the
inside front cover of this
workbook for author credits. 

2. Create a template for the
worksheet that will guide the
students as they explore
FoilSim. Launch Microsoft
Word, open a new document,
create tables and text fields (as
shown in the example on the
next page), print out a hard

copy,  and save the Word docu-
ment as a template. Make
copies that the students can
use to collect answers. They
can use the template to fill out
and turn in final worksheets
saved under their team names.

3. On the first day of this
activity, divide the class into
teams of three to five students.
Hand out the Student Activity
pages and worksheets. 

4. After the worksheets are
complete, review the answers
with the class. Then launch the
Curveball Competition to see
who can throw the fastest,
curviest strikes with the great-
est consistency using FoilSim.
Have each team record their
results in an Excel spreadsheet. 

5. Discuss the results in class.

Teacher Guide

FASTBALL PHYSICS

HIGH SCHOOL REQUIRED SOFTWARE

♦ MICROSOFT® WORD 98/2000

♦ MICROSOFT® ENCARTA® DELUXE ENCYCLOPEDIA 99

♦ FOILSIM WIND TUNNEL SIMULATOR (FREEWARE)

SUMMARY

OBJECTIVES

PREREQUISITE SKILLS

TIME ALLOTTED

HOW TO BEGIN

Microsoft Encarta provides a thorough introduction to aerodynamics.
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Ever wonder what keeps a
plane in the air? Would you be
surprised to know that it’s the
same force that keeps base-
ball players swinging and
missing? This lesson gives a
simple introduction to the
complex concept of aerody-
namic lift. And it might just
help you develop a wicked
curveball as well! 

Flight Factors
SOFTWARE: Microsoft
Encarta Deluxe Encyclopedia
99, FoilSim program, Word
98/2000

WHAT TO DO: Your teacher
will distribute a worksheet that
asks general questions about
aerodynamics as well as specif-
ic questions based on the
FoilSim program. Answer ques-
tions as you progress through
the steps. Later you can com-
pile your final answers and

submit a single completed
worksheet for the team.

1. With your teammates, re-
view the Encarta Encyclopedia
articles on aerodynamics and
lift. You’ll find additional infor-
mation in the FoilSim Help files.

2. Launch the FoilSim pro-
gram. FoilSim allows you to
study the aerodynamics of two
basic cross sections: an airfoil
and a baseball. Experiment
with the factors that affect lift
generated by the airfoil. 

3. Click the Activate Probe
check box beneath the Probe
Control “speedometer.” Use the
slider buttons to position the
probe in the slipstream above
and below the airfoil, and note
the airspeed and pressure at
different values of lift. 

4. Discuss the following
issues within your team and
be prepared to offer explana-
tions to the rest of the class:

♦ What is lift? How does it
relate to ---- but differ from ----
Bernoulli’s Principle?

♦ When you first launch
FoilSim or after you click the
reset button, the value of lift
is zero. Why?

♦ What is drag? How would it
affect the airfoil behavior if it
was modeled in FoilSim?

♦ What happens when an air-
foil “stalls?” Can you make the
FoilSim airfoil stall? Why or
why not?

Fly Ball
SOFTWARE: Microsoft
Encarta Deluxe Encyclopedia
99, FoilSim program,
Microsoft Word 98/2000

WHAT TO DO: Now that
you’ve experimented with an

FASTBALL PHYSICS

Student Activity
DESCRIPTION

STEP A

Your teacher will provide a work-
sheet to guide your study of lift.

The Great American Pastime would be not so great without the 
modest aerodymamics of the baseball.

STEP B
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airfoil, click the Play Ball but-
ton at the bottom of the
FoilSim window to investigate
the flight qualities of a base-
ball. Fill in your worksheet as
you go. You may have to refer
to the FoilSim Help or Encarta
Encyclopedia to answer some
of the following questions.

1. Notice that the side force,
which makes the ball curve in
flight, is always zero unless
the ball is spinning. Apply
some spin to the ball. What
happens to the side force?
Now apply spin in the other
direction. What happens? 

2. What causes the side
force? Use the probe to mea-
sure airspeed and pressure
around the spinning ball. How
does side force relate to the
lift generated by an airfoil?
Does the ball curve in the
same direction as the spin or
in the opposite direction?

3. If FoilSim simulated drag,
how would the flight of the
ball be affected? Which would

be more affected by drag, a
streamlined airfoil or a
sphere? 

4. Based on what you know
from FoilSim about baseball
spin and curve, can you spec-
ulate on how you might throw
a rising fastball, a sinker, and
a knuckleball?

Batter Up!
SOFTWARE: FoilSim pro-
gram, Microsoft Excel
98/2000

WHAT TO DO: It’s time to
give your aerodynamics
knowledge a workout. Can
you put your curveballs over
the plate?

1. In FoilSim, click the Play
Ball button to display the
baseball flight simulator. Select
Ballpark in the Plotter Control
Panel to display an aerial view
of the baseball diamond. 

2. Set up an Excel spread-
sheet like the one shown
above. You’ll be throwing 16

pitches with various combina-
tions of speed and spin. In the
Result cell for each pitch you
will enter a 1 for a strike or a
0 for a ball. Format the Strikes
cell to automatically calculate
your percentage of strikes by
dividing the sum of your
results cells by 16 (as shown
in the figure). Display your
strikes as a percentage on
your Excel table by selecting
the cell and going to Format
on the menu bar, choosing
Cells, clicking the Number
tab, and selecting Percentage
in the Category window. 

3. In FoilSim, before you start
pitching, select Right Hander
and Denver (for altitude). The
Release Point should be zero.

4. Now you’re ready to play
ball! Before each pitch, set
speed and spin to the values
specified in the table. Estimate
the release angle you will need
to compensate for the curve,
and type this value into the
Release Angle box. Also record
this value in the corresponding
cell in your table. Now press
the ENTER key and let your
pitch fly! No fair changing the
angle and pitching again. Just
record the results (1 or 0) and
move on to the next combina-
tion of speed and spin.

5. When done pitching, com-
pare your strike percentage
with the other teams and dis-
cuss the results. Do you have
a future in the big leagues?

6. Using your recorded
Release Angles, try pitching at
higher or lower altitudes, or
with a left-handed spin. Can
you explain the results in
terms of aerodynamics? 

FASTBALL PHYSICS

STEP C

A Microsoft Excel table makes it easy to organize your data and to 
automatically calculate your percentage of strikes.
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The last 100 years has been a
period of unparalleled achieve-
ments in science, medicine,
human rights, and more. In
this activity, students will
identify key figures in 20th 
century progress and then
document the life and times of
each in a searchable database.

♦ To expose students to 20th
century history and to the 
people who shaped it. 

♦ To introduce database tools
and organizing techniques.

♦ Basic experience with
Microsoft Word 98/2000 and
Microsoft Access 2000. 

♦ Basic research skills using
Microsoft Encarta Deluxe
Encyclopedia 99 and Microsoft
Internet Explorer 4.5/5.0.

♦ 4 ---  6 class periods

1. Launch Access. In the open-
ing dialog window, select
Create a new database using
blank Access database. When
the File New Database window
appears, name your database

“Giants of the Century” and
save it to a location accessible
to all your students.

2. When the Database window
opens, double-click on Create
table in Design view.

3. Create fields for Name,
Nationality, Area of Infuence,
Decade, Contribution, Picture,
and Sources. 

4. Click in the Data Type cell
for the Picture field. Click the
drop-down button and select
OLE Object from the list.

5. Click in the Data Type cell
for the Name field. Click the
drop-down button and select
Hyperlink. Do the same for the
Decade field. The students will
connect these links to their
proper destinations later.

6. By default, text fields hold
only 50 characters, but you’ll
want more room than this for
the Contribution and Sources
fields. To increase field size,
click on the field to display
Field Properties, and select the
General tab. Increase the Field
Size value to 255.

7. Close the table. You'll be
prompted to assign a primary
key, but you don’t need to
because the database will con-
tain only one table. 

8. Now design a form for enter-
ing information into the table.
In the Database window, click

Forms in the Objects column,
then double-click on Create
form by using wizard.

9. In the sequence of Form
Wizard dialog boxes, select all
available fields in your table,
then choose columnar layout
and a style for your form. 

10. In the final Form Wizard
dialog box, confirm a title for
your form, select Modify the
form's design, then click
Finish. The form will appear in
Design view.

11. To prevent images you
import into the database from
being clipped or distorted,
select the Picture field by
clicking on it, then select
Properties from the View
menu. Select the All tab, click
in the Size Mode field, and
select Zoom from the drop-
down list. Close the Properties
window.

12. Make any other changes
you like to the form in Design
view, either by selecting and
dragging objects to different
locations or by editing proper-
ties as in step 11. 

13. Close and save the data-
base. Now students can create
records (like the sample shown
on page 35) for the individuals
they’ve chosen and link them
to biographical and historical
information as described in the
Student Activity section. 
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Teacher Guide

GIANTS OF
THE CENTURY

HIGH SCHOOL REQUIRED SOFTWARE

♦ MICROSOFT® WORD 98/2000

♦ MICROSOFT® ENCARTA® DELUXE
ENCYCLOPEDIA 99

♦ MICROSOFT® INTERNET EXPLORER 4.5/5.0

♦ MICROSOFT® ACCESS 2000 (WINDOWS® ONLY)

SUMMARY

OBJECTIVES

PREREQUISITE SKILLS

TIME ALLOTTED

HOW TO BEGIN



One exciting way to look at
history is by studying the peo-
ple who shaped it. In this
activity, you and each of your
classmates will choose five
individuals who made the
world a better place during
the 20th century. Then, in a
single database, you’ll com-
bine information about their
lives, accomplishments, and
the historical events that
influenced their work.     

Giant Research
SOFTWARE: Microsoft

Encarta Deluxe Encyclopedia

99, Microsoft Internet

Explorer 4.5/5.0, Microsoft

Access 2000 

WHAT TO DO:

1. Think about the greatest
achievements of the 20th cen-
tury, in any and all fields of
human endeavor. Who made
them happen? What names
come to mind? Thomas
Edison? John Lennon? Mother
Teresa? Pick five people whose
accomplishments you admire

most, or who you’d like to
learn more about. 

2. Using Encarta Encyclopedia
and Internet Explorer, search
for images and  information
about the men and women
you’ve chosen. The URLs list-
ed below will help you get
started on the Web. Request
permission to reproduce
images if permission is not
explicitly given in the source.
Cite all sources you use. 

3. Use the Access form your
teacher has created to collect
information about each per-
son, including area of influ-

ence, and the decade and
nature of his or her major
contribution(s). 

4. When you enter informa-
tion in the Name and Decade
fields, it will appear blue and
underlined. These are hyper-
text links, but they won't work
properly until you connect
them to their appropriate 
destinations in Step D.

5. Find a picture of each of
your chosen history makers,
and include it the Access
record. To insert the image
into the form: 

♦ Click in the Picture frame to
select it.

♦ Go to the Insert menu and
choose Object.

♦ In the Insert Object dialog
box, select Create from File.
Then use the Browse button
to locate the image you have
saved so that the path to it
appears in the File box.

♦ Click the Link check box,
then click OK.

GIANTS OF THE CENTURY

Student Activity
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DESCRIPTION

STEP A

HISTORY ON THE WEB
http://history1900s.miningco.com/ --- A well-organized, word searchable site
with lots of history links, focusing on politics, art, science, and technology.

http://www.msstate.edu/Archives/History/USA/20th_C./twenty.html --- USA
history, especially politics and presidents, the economy, and popular culture.

http://www.pbs.org/wgbh/aso/databank/ --- Go here to find information about
people and events in science, technology and medicine over the last 100 years.

http://www.famouspeople.com/famouspeople.html --- Brief biographies of
famous people, from Ross Perot to the Spice Girls. 

You can use Microsoft Access to collect information about your 
history mak ers.



Get Personal
SOFTWARE: Microsoft Word
98/2000, Microsoft Encarta
Deluxe Encyclopedia 99,
Microsoft Internet Explorer
4.5/5.0

WHAT TO DO:

1. As a class, create a list of
all the people represented in
your database. Your teacher
will help you divide the list
evenly among all the students
in your class. 

2. Use Encarta Encyclopedia
(and Web resources if neces-
sary) to research and write
short biographies on the
individuals assigned to you ----
no more than a page each.
Each biography should be a
separate Word document.  

3. Make sure you use the
same margins, font, and other
formatting as your classmates
so that all your biographies
share a common look. 

4. Use the subjects’ last names
for your file names, and save
them to a shared directory
your teacher will set up. 

Make History
SOFTWARE: Microsoft Word
98/2000, Microsoft Encarta
Deluxe Encyclopedia 99,
Microsoft Internet Explorer
4.5/5.0 

WHAT TO DO:

1. Your teacher will divide the
class into ten teams and assign
each a decade to document.

2. Using Encarta Encyclopedia
and Web resources, research
and write a one-page Word doc-
ument highlighting the major
events of your assigned decade. 

3. Keep in mind that the pur-
pose of this document is to
provide a historical context for
the achievements of the men
and women you and your
classmates have chosen. The
scope of your history docu-
ment must be broad enough to
encompass events that may
have influenced all the “giants
of the century” who made
their major contributions dur-
ing your assigned decade.  

♦ Research tip: Encarta
Encyclopedia articles about
the people you have chosen

include links to related histor-
ical information. Encarta
Encyclopedia also contains a
timeline that provides an his-
torical big picture.

4. When you are done with
your history document, save it
in a shared directory (that
your teacher will set up) with
the name of the decade it rep-
resents, such as 1900-1910.doc.

Pull it All Together
SOFTWARE: Microsoft
Access 2000

WHAT TO DO: Now you can
link your records to the rele-
vant biography and history
documents. Here's how:

1. Open the “Giants of the
Century” database. In the
Database window, click Forms
in the Object column, then
double-click on the form name
to open it.

2. Go to each of the records
you created in Step A. Click on
the person's name, then cancel
any dialog boxes that appear.
The name will then be high-
lighted. Go to the Insert menu
and select Hyperlink to open
the Insert Hyperlink window.
Browse to the location of the
biography document for that
person and click OK. 

3. Repeat this procedure with
the decade you've entered in
the Decade field, but link to the
document that contains history
for the corresponding period.

4. Your “Giants of the Century”
database is complete. Browse
the records and discuss in
class. What does it tell you
about the 20th century?

GIANTS OF THE CENTURY
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STEP D
The Microsoft Encarta Encyclopedia Timeline gives you the big picture.

STEP B STEP C



Share lesson plans.
Prep for a new lesson with the assistance of Encarta Schoolhouse Lesson Collection ---  a collection of over 500
lesson plans written and tested by classroom teachers. Schoolhouse also features improved search and index
capabilities, easy access to Encarta Encyclopedia articles, MSN education community links, and many other
resources for teachers and students.

Find relevant information for your students.
Fast access to quality information is the Encarta difference. Its 13,500 editorially selected Web links were
chosen to speed you on your way to knowledge.

Satisfy your curiosity.
Find quick answers to your questions. Discover why millions of curiosity-seekers turn to
Encarta Online each month.

Knowledge is power.
With it, obstacles become smaller and boundaries disappear. Encarta is about 
knowledge and learning! Sign up now for a free 30-day trial of Encarta Online Deluxe.

Go to http://encarta.msn.com/promos. When prompted, enter Plan Code: EDU1321.
Offer expires 12/31/99

Encarta Online Deluxe
Special 30-Day Trial Offer for Educators!

Developed exclusively for teachers, Teaching and
Learning with Microsoft includes two CDs that feature 
education-specific templates, comprehensive training
resources, and classroom-tested ideas for using Microsoft
applications.

The first CD, Microsoft Office Classroom Tools, was 
created for use with Office for Windows and Office
Macintosh Edition. It's filled with Office add-in tools like
templates for teachers and students (old favorites plus nifty
new ones), activities that integrate Office into the classroom,
thousands of clipart images, file converters, and more.

The second CD, Microsoft Classroom Training Tools,
runs on Microsoft Windows and Macintosh computers. It

contains a number of comprehensive training resources
and classroom activities that integrate a variety of
Microsoft software.

We'd like you to have this 2-CD set of ready-to-use
resources so you can see for yourself how teachers and
students can get the most out of using Microsoft Office for
Windows® and Microsoft Office Macintosh® Edition in the
classroom. Order your copy of Teaching and Learning
with Microsoft today for just $4.95 ($7.50CN) to cover
shipping and handling expenses.

Hurry --- this offer is good only while quantities last! Don't
miss this chance to learn how Microsoft software can
enhance learning and increase teacher productivity. 

A world of exciting classroom possibilities, 
time-saving tools, templates, and teacher training resources. 

Order today at http://www.microsoft.com/education/k12/cdoffer.htm

FREE
2-CD SET

for cost of shipping and
handling only.

http://encarta.msn.com



Microsoft® Office 2000, Professional Edition
for Windows and Microsoft® Office 98
Macintosh Edition (Academic Editions)
Office 98/2000 integrates intelligent applications with the power 
of the Web. Easily insert hyperlinks between Office documents
or out to the Internet. Save your documents as HTML to 
create Web pages instantly. Office 2000, Professional Edition
for Windows includes: Microsoft Excel 2000, Word 2000,
PowerPoint 2000, Outlook 2000, and Access 2000 . Office 98
and Windows Standard Editions do not include Access 2000.
Office 98 includes Outlook Express instead of Outlook.
Windows 95, Windows 98, MacOS ; earlier version available
for Windows 3.1. Estimated Academic Price: $199.00,
Professional Edition and Office 98; $159.00, Standard Edition.
Volume pricing is available.
http//www .microsoft.com/office/
http//www .microsoft.com/macoffice/

Microsoft® Encarta® Africana
Watch the African world’s traditions unfold! Microsoft Encarta Africana brings the richness and
diversity of the black experience to life. Powerful learning tools such as on-location videos and
thousands of comprehensive articles help students and others discover the rich heritage of per-
sons of African descent. 
Windows 95, Windows 98, MacOS 
Estimated Retail Price $69.95, Open License (A) Estimated Academic Price $24.00.
http://www .encarta.msn.com/africana/home4.asp

Microsoft® Publisher 2000 (Academic Edition)
Create effective, high-impact publications and World Wide Web sites with Publisher 2000. It’s
perfect for all your classroom and home projects. In just minutes, you and your students can turn
ideas into professional-looking publications, in print and online. In and Out of the Classroom with
Publisher 2000, a teacher activity guide, is included in the Academic Edition of Publisher 2000. 
Windows 95 and Windows 98; earlier version available for Windows 3.1
Estimated Academic Price: $69.95.
www.microsoft.com/publisher/

098-83432SUPPLEMENT TO SCHOLASTIC INC.

Microsoft® FrontPage 2000 (Academic Edition)
Microsoft FrontPage makes creating professional-quality Web sites effortless with powerful new
functionality, support for the latest Web technologies, and great integration with Microsoft Office.
It’s never been easier to develop and maintain your own professional Web sites!
Windows 95 and Windows 98; earlier version available for MacOS
Estimated Academic Price: $69.95.
www.microsoft.com/frontpage/

Microsoft® Encarta® 99 Reference Suite
Encarta 99 Reference Suite for Windows combines Microsoft’s Encarta 99 Encyclopedia,
Encarta 99 Virtual Globe, and Bookshelf 99 to create the world’s most comprehensive desktop
reference library. (Complete suite available for Windows 95 and Windows 98 only; Encarta 98
Encyclopedia and Bookshelf 98 are available separately for the Macintosh.) 
Microsoft ® Encarta ® 99 Encyclopedia, Deluxe Edition - This newly updated version of
Microsoft’s award-winning, interactive multimedia encyclopedia for students and teachers turns any
classroom into a resource-rich research library. The Deluxe edition features Research Organizer, a

tool that teaches students research skills and information literacy while helping them turn Encarta information into
top-notch papers, reports, and presentations.  http://encarta.msn.com/products/ee99/ee99home.shtm
Microsoft ® Encarta ® Virtual Globe, 1999 Edition, the essential geographic reference companion to Encarta 99
Encyclopedia, brings you the world as never before with realistic 3-D maps, engaging multimedia, and authoritative
content. For quick facts, schoolwork, or armchair travel, Encarta 99 Virtual Globe is the newest way to visit and learn
about places, people, and cultures around the globe.  http://encarta.msn.com/evg/default.shtm
Microsoft ® Bookshelf 99 Reference Library provides ten quality desk reference works and other multimedia
resources to enrich your writing, including dictionary, thesaurus, famous quotations, and more. 
http://bookshelf.msn.com/na/default.asp
Windows 95, Windows 98, MacOS (Encarta 98 Encyclopedia and Bookshelf 98 only); earlier versions available
for Windows 3.1. Estimated Retail Price for Encarta 99 Reference Suite: $99.95, Open License (A) Estimated
Academic Price $35.00. Estimated Retail Price for Encarta 99 Virtual Globe: $54.95, Open License (A) Estimated
Academic Price $22.00. Estimated Academic Price for Encarta 98 Encyclopedia Deluxe: $64.95. 

Estimated prices are subject to change without notice.

Cross-platform productivity tools
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